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1 Allgemeines

Vielen Dank fiir die Verwendung des CANinterpreters. Das Tool ist ein vielseitig einsetzbares CAN-
Analysetool flir Entwicklungs-, Test-, Diagnose- und Serviceaufgaben. Das Handbuch erlautert die
Installation und Bedienung des Programms.

2 Installation

2.1 Windows

Zur Installation unter Windows fiihren Sie das Setup setup_caninterpretor.exe aus und folgen den
Anweisungen des Setups. Das Setup richtet ein Icon oder eine Verkniipfung im Programmmenii ein,
womit das Programm gestartet werden kann. Beim ersten Verbinden mit einem CAN-Interface wird
nach dem Pfad der Lizenzdatei gefragt, welche dann zum Programm kopiert wird.

Ohne Lizenzdatei kann das Tool fiir eine Stunde mit 125 kBit/s zu Evaluierungszwecken verwendet
werden.

Unter Windows werden folgende CAN —Adapter unterstiitzt:

Bezeichnung getestete Treiberversion Verweis

Ixxat/HMS CAN-Interfaces VCI V4 (4.0.162.0) Ixxat Support

Janz Tec CAN-USB 2.10 --

SYS TEC USB-CANmodul 6.05.0154 SYS TEC Driver

PEAK PCAN-USB 4.2.2 PEAK Driver

Kvaser CAN-Interfaces 5.31.0.0 Kvaser Driver

EMS Wiinsche CAN-Interfaces 2.2.3.0 --

Vector CAN-Interfaces (XL-Driver) | XL Driver 20.30.16 Vector XL Vector XL Driver
2.2 Linux

Zur Installation unter Linux ist die ZIP-Datei setup_caninterpreter.zip in das gewtlinschte Verzeichnis
zu kopieren und dort zu entpacken. Zum Start des Programms starten Sie das Skript
CANopenDeviceExplorer.sh im Installationsverzeichnis. Beim ersten Verbinden mit einem CAN-
Interfacce wird nach dem Pfad der Lizenzdatei gefragt, welche dann zum Programm kopiert wird.
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3 Erste Schritte

Der erste Schritt beim ersten Programmstart ist die Konfiguration des CAN-Interface. Offnen Sie
dazu die CANopen-Interface-Einstellungen unter dem Meniipunkt ,,Connection —> CAN Interface
Settings” Es erscheint folgende Eingabemaske:

EM CAN Interface Overview

Saved interfaces Current interface
1D Name Primary Active Flags
1 emotas USE - COMA ® v m Interface Type emotas Virtual A
2  emotas USE - COM2 v m CAN Device emotas Virtual "
. |emotas Virtual - Bitrate 500 kbitfs -
AN T Y T
Available interface settings
Listen-Only Mode (LO) V| Auto bus on (Auto)
Log error frames (EF) Low speed (LS)
System time as timestamp Continuous system timestamp

Adapter changed - Update current adapter or add new interface.
Clear all |Remove selected | Add new interface | |Update selected interface

Close

Wahlen Sie nun den Typ der CAN-Schnittstelle, den Namen des CAN-Gerdtes und die Bitrate im
CANopen-Netzwerk und bestdtigen Sie die Auswahl mit ,,Add new interface™ und schlieBen Sie den

Dialog mit Close.

Verbinden Sie das Programm nun mit dem CAN-Interface iiber den Meniipunkt ,,Connection —>
Connect” In der Statuszeile das Programms sehen Sie nun ,,Connected to ... “ sowie den Namen des
CAN-Gerats und die aktuelle Bitrate.

emotas Virtual - emotas Virtual (1000 kBitfs) -0 % =
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4 CAN Mehrkanal Handhabung

4.1 Allgemein

Mit Version 2.13.0 dieses Tools wurde die Moglichkeit hinzugefiigt sich gleichzeitig mit mehreren CAN
Adaptern zu verbinden, sofern dies Ihre Lizenz unterstiitzt. Es gibt hierbei stets einen primdren
Adapter und die Maglichkeit weitere Adapter aktiv zu setzen.

Uber den primaren Adapter werden alle Schreib-Aktionen des Tools gehandhabt. Hierzu gehéren zum
Beispiel die Interaktion mit dem Objekt-Browser, Network Overview, PDO Configuration, PDO Tx & Rx,
aber auch das Scripting, LSS Master etc.

Die CAN Nachrichten der aktiven Adapter werden in den unterstitzten CAN — Analyzern angezeigt.
Zu den unterstiitzten Analyzern gehoren CAN View, CAN Object View, CANopen Interpretation,
CANopen Object View, EnergyBus Object View, User-defined Interpretation, J1939 Interpretation,
J1939 Object View und ISO-TP Interpretation.

Jeder Adapter hat seine einzigartige ID. Siehe nachfolgenden Screenshot. Diese ID findet sich in den
einzelnen CAN —Analyzern in der Spalte ,,IF* wieder.
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4.2 Konfiguration

Die Konfiguration mehrerer CAN Linien erfolgt iiber den ,,CAN Interface Overview“ Dialog.

EM CAN Interface Overview

Saved inberfaoeso Currentinterfaoeo

] Name Primary Active Flags

1 emotas USE - COM1 ) v m Interface Type emotas Virtual hd

2 | emotas USE - COM2 v m CAN Device emotas Virtual -

3 cmotes Virtual v o) N i g

Available interface settings
o Listen-Only Mode (LO) v | Auto bus on (Auto)
Log error frames (EF) Low speed (LS)
System time as timestamp Continuous system timestamp
Adapter changed - Update current adapter or add new interface. o
Clear all |F‘.en‘|ove 5e|ected| Add new interface | |Update selected interface
(5 ) 6 ] 2] o
o Close

1. Der Bereich ,Current Interface” beinhaltet alle Angaben des derzeit ausgewdhlten oder
moglichen neuen Adapters.

2. ,Add new interface” fiigt die derzeitigen Einstellungen aus ,,Current Interface” als neuen
Adapter der Liste hinzu.

3. ,Update selected interface™ aktualisiert den derzeitig ausgewahlten Adapter in der linken
Liste auf die neuen Einstellungen.

4. Die Ubersicht ,Saved Interfaces” zeigt die derzeitig gespeicherten Interfaces an. In dieser
Liste ist stets ein Adapter der primare und somit auch aktiv. Desweiteren konnen bei
entsprechender Lizenz mehrere Adapter aktiv gesetzt werden.

5. ,Clear all“16scht alle eingestellen Interfaces.

6. .Remove selected” 16scht das derzeit ausgewdhlte Interface.

7. Der Hinweis ,,Adapter changed — Update current adapter or add new interface” taucht auf,
sobald ein Adapter ausgewahlt ist und die Eingabemaske vom Nutzer gedndert wurde.
Es ist dann notig die Anderungen fiir den aktuellen Adapter zu libernehmen oder ihn als
neuen Adapter hinzuzufiigen.

8. .Close" schlieBt den Dialog.

9. Die Spalte Flags hebt die gesetzten Flags fiir den Adapter hervor. Folgende Abkiirzungen

werden verwendet:
FD - CANFD
EF - Error frames

LO - Listen-Only Mode
LS - Low Speed

Auto - Auto bus on
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4.3 Globale Nutzung

Nachdem Einstellen mehrerer aktiver Adapter und dem erfolgreichen Verbinden befindet sich im
Hauptfenster ein neuer Meniieintrag ,,CAN Interfaces" Uber dieses Menii kann jederzeit der priméare
Adapter geandert werden.

Pluglns Windows Help EeAIRGITEEE:
| emotas USE - COR1

B =motas USE - COM2

eiotas

= emotas Virtual - emotas Virtual
- PDO Configuration

4.4 Nutzungim CAN Analyzer

Jeder unterstiitzter Analyzer zeigt die ID des Adapters in der Spalte YIF Time

»IF* an und besitzt die Mdglichkeit die CAN-Nachrichten der 19 41656.772000 156
verschiedenen Adapter anzuzeigen, auszublenden und einzufarben.Der ;5 jﬁ__mmas USB-COM2] 156
Tooltip der Spalte verrat den Namen des derzeitig eingestellen ol e PP — -
Adapters der ID.

Beachten Sie, dass beim Im- und Export der Daten nur die ID und nicht der entsprechende Adapter
gespeichert wird.

Schnellfilter

In den einzelnen Ansichten kann jeder aktive Adapter schnell ausgeblendet werden indem mittels
Rechtklick auf den Titel der Spalte ,,IF* geklickt wird. Hier 6ffnet sich ein Menii mit allen aktiven
Adaptern, welche durch einfachen Klick deselektiert werden konnen. (Punkt 1)

Da es vorkommen kann, dass z.B. nach dem Import alter Daten, die derzeitige Liste der aktiven
Adapter nicht mit den der angezeigten Daten libereinstimmt, kann jeder Adapter mit seiner
eindeutigen ID gefiltert werden, indem diese ID in die kommaseparierte Liste eingetragen und mit
Enter bestatigt wird. (Punkt 2) Die ID der Adapter sind in der Spalte ,,IF“ dargestellt.

CAM Rx

TIF Time CAN-ID Type L
19 Show all

I o
3 1 - emotas USE - COM1
v 2- emotas uss - com2

a7 3 - emotas Virtual - emotas Virtual
292 8 e st igwFd bl

[o= == T = = T A = T == R = =
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Konfiguration im CAN Analyzer

In jedem View ist liber den Meniipunkt ,,Configuration® eine erweiterte Konfiguration der Adapter
maglich. Hier kann ebenfalls der Adapter ein- oder ausgeblendet, als auch die Schriftfarbe der CAN
Nachrichten fiir den Adapter gesetzt werden.

EM CAM View Configuration

@ General IE Name Show
#/ Highlights 1 emotas USB - COM1 v
) Treshold Colors | 2 emotas USE- COM2 v B
“F Filter 3 emotas Virtual - emotas Virtual v
ill Interfaces o o

| Apply | QK Cancel

Mit den Kastchen der Spalte ,,Show™ (Punkt 1) lassen sich die CAN Nachrichten der Adapter wie mit
dem Schnellfilter ein und ausblenden. Mit den Buttons der letzten Spalte (Punkt 2) lasst sich die
Schriftfarbe andern. Die Buttons sind entsprechend der eingestellen Schriftfarbe eingefarbt.
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5 Programmkomponenten und Plugins

5.1 CAN View

CAN View

=

Autoscro

CAN Rx

299 |1
300 (1
301 [1
302 [1
303 [1

CAN Tx

L I

Der CAN View zeigt empfangene und gesendete CAN-Nachrichten an. Zum Senden von CAN-
Nachrichten kann die untere CAN Tx-Tabelle verwendet werden. Die Werte fiir CAN-ID, DLC und
die Daten konnen als Dezimalzahl oder als Hexadezimalzahl mit fiihrenden ox angegeben
werden.

Es konnen bis zu 15 Sende-Nachrichten definiert werden. Die jeweils aktive Nachricht wird bei
einem Klick auf dem Transmit-Button gesendet. Ist in der Spalte 'Interval(ms)' ein Wert
ungleich o eingetragen, so wird die Transmit-Nachricht zyklisch gesendet.

Im Menu des CAN-View kann eine Filter nach CAN-IDs definiert werden. Dabei kann eine Liste
von CAN-IDs definiert werden, welche entweder angezeigt oder ignoriert werden sollen. Die
Liste kann als Liste einzelner Ids (z.B: 100,200,300,400) oder als Bereich (z.B. 0x100-0x200)
oder kombiniert angegeben werden. (Beispiel: 0x100-0x222,0x400,0x720, 0X740).

Der Filtertyp legt das Verhalten des Filters fest:
* PASS—es werden nur die definierten CAN-IDs angezeigt

* REJECT — es werden die definierten CAN-IDs ausgefiltert und alle anderen werden
angezeigt.

* NONE-es wird gar nicht gefiltert

L1 ~
@ =~ HEX w 435,/2000000 Clear view
Relative time Filter enabled Refresh

Time CAN-1D Type Len 0 1 2 3 4 5 6 7 Motes -

0.002682 1535/ 5FF 8 Ox60 | Ox00  Oxla | Ox02 | O0x00  Ox00  OxO0 | OxDO

0.001257 1663/0x67f 8 Oc2f  Ox00 Oxla (00 Ox02 OO0 (00 Ox0O0

0.002632 1335/ 0ue 5FF 3 Ox60 | 0x00 Oxla  Ox00 Ox00 Ox00 Ox0D | Ox00

0.001213 1663/ 0x67f 8 0x23 Ox00 D18 Ox01  Oxff  Ox01 Ox00 Ox00

0.002634 1335/ 00 5fF 8 060 | 0x00 | 018 | 001 | 0x00 | 0x00 | OocDD | 000 =
Interval (ms) CAN-ID  Type len 0 1 2 3 4 5 ] 7 Mame -
1000 e 1 1
1000 Oxd 2 Oxl w2
1 e 3 Ol |02 w3
1 Oxf 4 Ox1 |02 Ox3  Oxd
1 O 7HE 8 Cuff | Oneff  Oneff  Owff Oueff  Oneff  Owff  Ouff =

Transmit
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Die Zeitstempel der Empfangsnachrichten konnen jeweils absolut und relativ (zur letzten
Nachricht) dargestellt werden.

Die aufgezeichneten CAN-Nachrichten konnen tiber CAN View->Export CAN-Logging in
Textdateien exportiert werden.

Das Format der aufgezeichneten CAN-Telegramme hat folgende Form in der exportierten
Textdatei:

3.652109 0x5a0/1440 (8): 43 18 10 02 15 00 08 00

3.654306 0x620/1568 (8): 40 18 10 04 00 00 00 00

3.653302 0x5a0/1440 (8): 43 18 10 03 00 00 00 00

Zeitstempel

CAN-ID
DLC
Daten im hexadezimalen Format
Die Genauigkeit der Zeitstempel hangt vom verwendeten Betriebssystem und CAN-Interface

ab. Der Sendezeitstempel ist nicht fiir alle CAN-Schnittstellen verfiigbar.

Relative Zeiten

Wenn ,relative time” gesetzt ist, so kann jede Nachricht als Zeitreferenz mittels Rechtsklick
und ,Use messages as time reference” gesetzt werden. Die relativen Zeiten aller anderen
Nachrichten werden dann zu dieser berechnet.

Des weiteren, kdnnen die Nachrichten farblich hervorgehoben werden, wenn ,relative time®
gesetzt ist. Die Einstellung der Schwellwerte und Farben erfolgt tiber das Menu ,,CAN View ->
Configuration”.

EM CAM View Configuration

'@' General v | Activate relative time colors
7 Highlights Highlight type Color background of time column =
‘.'J Treshold Colars | 0,500 |= i

"7 Filter
1,000 |=

i Interfaces
2,000 |2

EOE

All relative times upper the time set will be highlighted. +

Apply QK Cancel

In diesem Fenster konnen Schwellwerte fiir die relativen Zeiten eingestellt werden. Wird
dieser lberschritten, wird die Nachricht in der eingestellten Farbe angezeigt.
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5.2 CAN Object View

Das CAN Object View zeigt alle empfangenen CAN-Nachrichten in der sogenannten ,,Object
View“-Ansicht an. Dabei werden tabellarisch alle empfangenen CAN-IDs mit den letzten
empfangenen Werten angezeigt.

CAM Object View

BE ¢ |7 ©
HEX v Clear view
Aurtosono Relative time Toggle filter Refresh

Count - IF Tirme CAN-ID Type Len 0 1 2 3 4 5 5] 7
468.267... | 511/0x1f ] Ox0d 000 000 Ox00 OO0 | 000

468.866...  1919/0x... 1 005

197.385...  1663/0x... 8 0x23 | 0x00 |18 01 Owff  Ox01  Ox00  Ow0O
197.388...  153%/kx... 8 Oxed k00 Ox18 | Ox01 | OO0 GO0 Coe00 | OkOO

— | ot [ b [

Die Tabelle kann nach der Anzahl, der Empfangszeit und der CAN-ID sortiert werden. Eine
Filterung ist analog zum CAN View verfiigbar.

CAN Object View Configuration

Zur besseren Analyse besitzt das CAN Object View die Mdglichkeit sich andernde Bytes
hervorzuheben, als auch Zeilen hervorzuheben, wenn eine CAN ID eine zeit lang nicht
empfangen wurde. Diese Einstellungen sind iiber das ,,CAN Object View“-Menii unter
~Configuration® zu finden.

General
¢ Refresh interval

Diese Zeit bestimmt, wie oft sich die Ansicht aktualisiert. Je niedriger diese Zeit,
desto mehr Rechenzeit wird bendtigt

* Highlight changed bytes

Wenn diese Option aktiviert ist, werden die einzelnen Bytes fett-gedruckt dargestellt,
wenn sich die Daten von Nachricht zu Nachricht geandert haben.

Filter

Die Funktionsweise der Filterung entnehmen Sie bitte der Beschreibung des CAN View.
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Highlighting

Im Highlighting-Tab kann fiir eine bestimmte oder alle CAN Ids eine Textfarbe eingestellt
werden, fiir den Fall das eine oder alle CAN Ids eine gewisse Zeit nicht empfangen werden.

EM CAN Object View Configuration

@' General CAM ID Highlighting

f Highlights You can set the text color for a spedfic CAN ID or all CAM IDs

when the set time is exceeded,
" Filter

-

2,000 |« | | AlIDs * | | Ox0 Al

P

|

i Interfaces

0,500 |%| | SpedficID = ||Ox1 |3

1000 || |specficn ~ |[oxz ST | 50

o

Insert a mew entry by dicking + on the right side +

| Apply | oK Cancel

1. Erstellen eines neuen Eintrags zur Konfiguration
2. Zeit in Sekunden, nach welcher die Textfarbe der Zeile geandert werden soll.

3. Auswahl zwischen ,,Specific ID* und ,,All IDs’, womit bestimmt wird fiir welche ID die
Einstellungen dient.

4. Auswahl der Farbe
5. Loschen des Eintrags
6. Einstellen der spezifischen CAN ID
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CANopen Interpretation
Auto Seroll (W] hex dreular Y7 L Update Model Clear
Time Stamp CAN-ID Type MNode-1d Data Interpretation -
1491479795.991180 1409/0x581  5DO 1 - device accarding CiA 401 431810021508 0000 r Res exp 1018:2 Val 0x815
1491479795.995680 1409/0:581  5DO 1 - device according Cif 401 4318100301 0001 00 r Res exp 1018:3 Val 0:10001
- 1491479795.995680 1537/0:601  SDO 1 - device according Cis 401 40181003 00 00 00 00 r Req - 1018:3
» 1491479796.039180 1537/0x601 SDO 1 - device according CiA 401 40181004 00 00 00 00 r Req - 1018:4
1491479796.041180 1409/0x581  5DO 1 - device accarding CiA 401 43181004 01 00 00 00 r Res exp 1018:4 Val 0xl
4 1401479796.300180 1793/0x701  Error Control 1 - device according CiA 401 05 Operational
toggle Bit 0

Mode State Operational

0 62 2004510

Read Analogue Input 16 Bit:Dial left (5401:1) = 0

Read Analogue Input 16 Bit:Dial right (6401:2) = 17162
Read Analogue Input 16 Bit:Slider left (6401:3) = 20048
Read Analogue Input 16 Bit:Slider right (6401:4) = 0

+ 1491479796.918180 385/0x181 PDO 1 - device according CiA 401 00 00 0a 43 38 52 00 00 017162 21048 0
1491479797.262180  385/0x181 PDO 1 - device according CiA 401 00 00 0a 43 20 56 00 00 017162 22048 0
+ 1491479797.340180 1793/0x701  Error Control 1 - device according CiA 401 05 Operational
© 1491479797 582180  385/0x181 PDO 1 - device according CiA 401 00 0014 21 20 56 00 00 08468 22048 0
+ 1491479797.670680  385/0:181 PDO 1 - device according CiA 401 00 00 aa 22 20 56 00 00 08874 220480
- 1491479797.725180  385/0:181 PDO 1 - device according CiA 401 00 00 5a 24 20 56 00 00 09306 22048 0
- 1491479797 965680  385/0x181 PDO 1 - device according CiA 401 00 00 ba 3b 20 56 00 00 015290 22048 0
1491479797.991680 1409/0x581  SDO 1 - device according CiA 401 4£18 10 00 04 00 00 00 r Res exp 1018:0 Val 04
> 1491479797 991180 1537 Mhdhll Sno 1 - devire arcardina Cid 401 A 1R 100000000000 r Ren - 10180 b

264 (264) messages

Der CANopen Interpreter interpretiert alle empfangenen CAN-Nachrichten entsprechend
dem CANopen-Protokoll und zeigt den CANopen-Typ der Nachricht, die Quell- oder
Zielknotennummer sowie dienstspezifische Daten in lesbarer Form an. Anhand der EDS- bzw.
DCF-Dateien der Gerate in Netzwerk ist zudem eine Interpretation der PDO-Dateninhalte
entsprechend des Mappings des Senders maglich.

Eine Filterung der CAN-Nachrichten ist nach verschiedenen Kriterien maglich:

* CANopen Dienste:
Es werden nur die aktivierten CANopen-Dienste angezeigt

* CANopen NodelD:
Es werden nur die ausgewahlten Knotennummer angezeigt. Eine Definition von Bereichen
wie z.B.(1,2,30-50) ist moglich.

+ Additional CAN-IDs:
CAN-IDs, welche durch die vorherigen Filter ausgeschlossen wurden, konnen selektiv wieder
zugelassen werden. Eine Definition von Bereichen wie z.B.(1-0x100,0x400) ist moglich.

* Exclude CAN-IDs:
CAN-IDs, welche die vorherigen Filter passieren, konnen selektiv ausgeschlosssen werden.
Eine Definition von Bereichen wie z.B..1-0x100,0x400) ist moglich.

Interpretierte Nachrichten konnen als Textdatei exportiert und wieder importiert werden.
Zudem ist der Import von uninterpretierten CAN-Nachrichten moglich.
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5.4 CANopen Object View (optional)

Der CANopen Object View kombiniert die CANopen Interpretation mit einer Objektview-
Ansicht so das alle empfangene CAN-IDs mit ihren letzten Werten interpretiert dargestellt
werden.

Der CANopen Object View unterstitzt ebenso wie der CAN Object View das Hervorheben
einzelner Zeilen, wenn eine CAN ID fiir eine gewisse Zeit nicht kam. Die Konfiguration kann
unter CAN Object View Highlighting nachgelesen werden.

5.5 EnergyBus Object View (optional)

Der EnergyBus Object View kombiniert die EnergyBus Interpretation mit einer Objektview-
Ansicht so das alle empfangene CAN-IDs mit ihren letzten Werten entsprechend der
EnergyBus-Spezifikation interpretiert dargestellt werden

© EnergyBus Interpreter

Can Nachrichten werden entsprechend der EnergyBus-Spezifikationen interpretiert.

5.6 User-defined Interpretation

Die User Interpretation ermoglicht die Anzeige von interpretierten CAN-Daten entsprechend
den Einstellungen des Anwenders.

5.7 File Logger

Der File Logger ermoglicht das direkte Aufzeichnen von CAN-Nachrichten in Logdateien
entsprechend bestimmter Triggerbedingungen

5.8 CAN Replayer

Der CAN Replayer ermoglicht das Senden aufgezeichneter CAN-Loggings. Beim Senden der
CAN-Daten konnen einzelne CAN-Ids ausgelassen werden. Das Zeitverhalten des Loggings wird
so gut wie moglich reproduziert.
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5.9 CAN Nachrichten Handling

Die empfangenen Nachrichten werden ab dem Wert der ,,Maximal message count” (einstellbar in den
Options) auf der Festplatte als Nachrichtenpaket gespeichert und aus dem internen Buffer entfernt.
Der interne Buffer fangt zu diesem Zeitpunkt wieder bei Null an.

Die gespeicherten Nachrichten lassen sich iiber das Menii rechts oben im aufrufen.

File Connection 5ettings Pluglns Help CAN View Live
L& MO efotas ’
Clear complete buffer
CANM View 0.003000 - 1.497000
=RNC Y oz X
HEX
Autoscroll Relative time Toggle filter Refresh b 3.007000 - 4.506000
4.507000 - 5.934000
CAM Rx S mmerrrr -
Time CAN-ID Type Len ] 1 2 3 4 5 6 7 Motes |*
7818 7.164000 1983/0x7bf ]
7819 |7.164000 1910/0x776 3 OxcS | 0x88 0x7e
7820 |7.164000 1873/0x751 4 0x99 | 0x86 Ox8e 0Ox24
7821 7.165000 752/0x2f0 1 Oxac
7822 7.165000 899/0x383 2 0x8f  0Oxlc
7823 7.165000 358/0x166 7 0x78  0x79 Oxf4  Oxd4  Oxd9 0x@® Oxf3
2074 |7 ARENNN | 4440w he 1 MrEf b
CAM Tx
o Interval (ms) CAN-ID  Type len O 1 2 3 4 5 ] i Mame =
1 1 ox6c3 5 0xf3  Ox4 0x31 0Oxd5 Oxd4
2 1 0xbds 3 Oxe2 0x52 0x53
3 1 0x363 ] 0x93 0xB9 0x91 Oxb2 O0xb2 0xf Oxf5 Ox52
4 1 (xbae g8 Oxca Ox78 Ox54 0x79 OxBb Ox2f 0Ox00 0Ox39
5 1 0x7e2 3 0xa7 Oxa  Oxbf
& 1 0x278 7 Oxfa ' Ox7b 0x72 0x96 0xBd  0Oxld  Ox5d b
Transmit
Connected to emotas Virtual - emotas Virtual (250 kBit/s) [active]

Die Namensgebung der gespeicherten Nachrichten folgt dem Zeitstempel der ersten und letzten
Nachricht des Nachrichtenpakets.

Wird ein altes Nachrichtenpaket ausgewahlt, so werden nur diese Nachrichten angezeigt. Neue
Nachrichten werden im Hintergrund empfangen und konnen mit dem Meniipunkt ,Live" wieder
angezeigt werden.
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6 Meni

Das Menii bietet Zugriff auf verschiedene Funktionen und Einstellungen des CANinterpreters.
File
» Export CAN Logging

Export der CAN-Telegramme als Text-Datei. Spaterer Import und Interpretation in den
Pluglns ist moglich.

*  Quit

Beendet das Programm.

Connection
* CAN Interface Settings
Dialog zur Konfiguration der CAN-Schnittstelle und der aktuellen Bitrate
* Connect
Aufbau einer Verbindung mit dem CAN iiber die konfigurierte CAN-Schnittstelle
* Disconnect

Trennen der Verbindung mit der CAN-Schnittstelle

Settings
+ Filter Settings

Konfiguration des Filters der CAN-Nachrichten. Der Filter wirkt sich nur auf die
Hauptkomponente aus. Alle PlugIns haben separate Filtermaglichkeiten.

» Options
Offnet den Einstellungsdialog zur Konfiguration verschiedener Programmeinstellungen .
+ Save

Die aktuellen Einstellungen werden gespeichert. Unter Setting —> Options — ,,Save settings
automatically at exit” kann eine automatische Speicherung der Einstellungen beim Beenden
des Programms aktiviert werden.

+ Export Settings

Export der aktuellen Einstellungen in eine Konfigurationsdatei. Damit kdnnen beispielsweise
flir verschiedene Anwendungsszenarien unterschiedliche Konfigurationen gespeichert
werden.

» Import Settings
Import der Einstellungen aus einer Konfigurationsdatei.
+ Update Licence File

Dialog zur Auswabhl einer (neuen) Lizenzdatei. Der Inhalt der bisherigen und der neuen
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Lizenzdatei wird angezeigt und die neue Datei kann kopiert werden.

* Check for Updates

Abfrage an den Webserver, ob eine neue Version des CANinterpreters verfiigbar ist. Dabei
werden auBer der IP-Adresse keine Daten von Ihrem Computer Ubermittelt.

PlugIns

Aktierungsmoglichkeit fiir diverse Erweiterungen des CANinterpreters. Die Verfiigbarkeit der Pluglns
hangt von den jeweils lizenzierten Pluglns ab.

Help

* Manual
Anzeige des Handbuchs im PDF-Format.

* About
Anzeige des About-Dialogs mit Lizenzinformationen.

* About Qt
Information uiber das Qt-Framework mit Lizenzinformation der verwendeten Qt-
Komponenten.
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7 Einstellungen

7.1 CAN-Einstellungen

Der CAN-Einstellungsdialog dient zur Konfiguration der CAN-Schnittstelle. Mit Version 2.13.0 wurde
die Unterstutzung mehrerer Kanale eingefiigt. Die Mehrkanal Nutzung ist im Kapitel CAN Mehrkanal
Handhabung beschrieben. Unabhdngig der Lizenz konnen immer mehrere Adapter gespeichert
werden, jedoch nur bei einer Mehrkanal-Lizenz auch mehrere parallel genutzt werden.

EM CAN Interface Overview ? X
Saved interfaces Current interface
[¥] MName Primary Active Flags
1 emotas USE - COM1 ® v m Interface Type emotas Virtual -
2 emotas USE - COM2 v m CAM Device emotas Virtual -
- |emotas Virtual - Bitrate 250 kbitfs -
AN T Y T W
Available interface settings
Listen-Only Mode (LO) V| Auto bus on (Auto)
Log error frames (EF) Low speed (L5)
System time as timestamp Continuous system timestamp
Clear all |Remove selected | Add new interface | | Update selected interface

Close

* Interface Type

Auswahl der Art der CAN-Schnittstelle. Unter Linux wird aktuell SocketCAN und canglinux und
unter Windows werden diverse CAN-Interfaces unterstiitzt.

¢ CAN-Device

Je nach Art des Interface Typs kann hier der Name des CAN-Gerats eingestellt werden.
Ubliche Namen fiir SocketCAN sind cano, cani, ... vcano und bei beispielsweise PCANBasic usb1
... usb8.

* Bit Rate

Konfiguration der Bitrate im CAN-Netzwerk. Stellen Sie hier die Bitrate ein, die auch fiir alle
anderen Gerate im CAN-Netzwerk eingestellt ist. Bitte beachten Sie, dass bei der Verwendung
von SocketCAN die Bitrate vor dem Start des Programms eingestellt werden muss.

* Advanced Settings

Bei verschiedenen CAN-Interface-Typen besteht die Moglichkeit weitere Optionen
einzustellen. Diese Optionen hangen vom CAN-Interface ab. Mogliche Einstellungen sind:

o Listen-Only-Mode
© Nutzer-spezifische Bitrate

o Aktivierung des AbschluBwiderstands
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7.2 Programmeinstellungen

Der Optionendialog bietet Zugriff auf verschiedene Programmeinstellungen.

General —Allgemeine Einstellungen
* Warning when exit with active CAN connection

Konfiguration, ob eine Warnung angezeigt werden soll, wenn das Programm bei bestehender
CAN-Verbindung beendet wird.

* Save Settings automatically at exit

Konfiguration, ob die Einstellungen automatisch beim Beenden des Programms gespeichert
werden sollen.

* Auto Connect to CAN after startup
Automatischer Aufbau einer Verbindung zum CAN-Interface beim Start des Programms
Scripting
* Autostart Script at connect

Das Autostart-Skript wird automatisch gestartet, wenn der Scripting Interpreter aktiv ist
und eine Verbindung mit dem CAN hergestellt wird. In Verbindung mit ,,Auto Connect to CAN
after startup” wird das Skript automatisch nach dem Start des Programms gestartet.

8 Support & Kontakt

Bei Fragen und Problemen unterstiitzt Sie unser Supportteam gern per E-Mail (support@emotas.de)
oder telefonisch unter der 03461/794160. Falls sich das Gerat anders verhalt als erwartet ist oft ein
Logging der CAN-Kommunikation bei der Analyse der Ursachen hilfreich. Bitte schicken Sie uns daher
bei solchen Fragen einen Mitschnitt der CAN-Kommunikation per E-Mail; idealerweise auch vor einer
telefonischen Kontaktaufnahme.
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